
IBM SPSS Modeler Lizenz für
gleichzeitig angemeldete Benutzer
Administratorhandbuch

���





Inhaltsverzeichnis

Administratorhandbuch . . . . . . . . 1
Vorbereitungen . . . . . . . . . . . . . 1

Citrix- und Terminaldienste . . . . . . . . 1
Gemischte Lizenzierung . . . . . . . . . 2

Installieren des Concurrent License Managers . . . 2
Durchführen eines Upgrades für den Lizenzmana-
ger . . . . . . . . . . . . . . . . 3
Installieren des Lizenzmanagers unter Windows . 3
Installieren des Lizenzmanagers unter UNIX/
Linux . . . . . . . . . . . . . . . . 4
Installieren des Lizenzmanageradministrators . . 4

Produktlizenzierung . . . . . . . . . . . . 4
Verwenden des Lizenzautorisierungsassistenten
(nur Windows) . . . . . . . . . . . . 5
Installieren einer Lizenz über die Eingabeaufforde-
rung . . . . . . . . . . . . . . . . 6
Aktivieren für die temporäre Verwendung . . . 7
Hinzufügen einer Lizenz . . . . . . . . . 7
Anzeigen der Lizenz. . . . . . . . . . . 8

Testen des Lizenzmanagers . . . . . . . . . 8
Installieren des Produkts auf lokalen Desktop-Com-
putern . . . . . . . . . . . . . . . . 8

Übertragen einer Installation an Windows-Compu-
ter . . . . . . . . . . . . . . . . . 9

Verwalten der Lizenz für gleichzeitig angemeldete
Benutzer . . . . . . . . . . . . . . . 11

Starten der Anwendung WlmAdmin . . . . . 11
Hinzufügen eines Servers. . . . . . . . . 11
Abrufen von Protokollinformationen . . . . . 12
Anzeigen der Details zu einer Lizenz . . . . . 12
Einrichten von redundanten Lizenzservern . . . 12
Konfigurieren von Pendlerlizenzen . . . . . 14
Konfigurieren von Lizenzreservierungen. . . . 15
Starten und Stoppen des Lizenzmanagers . . . 17
Deinstallieren des Lizenzmanagers . . . . . 17
Deinstallieren des Lizenzmanageradministrators 18
Fehlerbehebung bei Problemen mit den Desktop-
Computern . . . . . . . . . . . . . 18

iii



iv IBM SPSS Modeler Lizenz für gleichzeitig angemeldete Benutzer Administratorhandbuch



Administratorhandbuch

Die folgenden Anweisungen gelten für Administratoren an Standorten mit dem Lizenztyp Lizenz für
gleichzeitig angemeldete Benutzer für IBM® SPSS Modeler 16. Mit dieser Lizenz können Sie IBM SPSS
Modeler auf beliebig vielen Computern installieren. Allerdings hängt die Anzahl der Benutzer, die die
Anwendung gleichzeitig ausführen können, davon ab, für wie viele Personen die Lizenz erworben wur-
de.

Vorbereitungen
Sie benötigen Ihren Autorisierungscode. Mit dem Autorisierungscode können Sie eine Lizenz für den
Concurrent License Manager abrufen. Der Concurrent License Manager steuert die Lizenz für gleichzei-
tig angemeldete Benutzer und ermöglicht den Endbenutzern die Ausführung von IBM SPSS Modeler.

Sie sollten separate Anweisungen zum Abrufen Ihres Autorisierungscode erhalten haben. Wenn Sie Ihren
Autorisierungscode nicht finden können, wenden Sie sich an den Kundendienst, indem Sie die Website
http://www.ibm.com/software/analytics/spss/support/clientcare.html aufrufen.

Führen Sie die folgenden Schritte aus, um sicherzustellen, dass Sie die Lizenz für gleichzeitig angemelde-
te Benutzer ordnungsgemäß eingerichtet haben:
1. Installieren Sie den Concurrent License Manager. Der Concurrent License Manager ist ein Dienst-

programm, das Endbenutzern die Lizenz für gleichzeitig angemeldete Benutzer bereitstellt. Sie können
den Lizenzmanager auf einem beliebigen Computer in Ihrem Netz speichern. Üblicherweise handelt
es sich dabei um einen Server, an den Desktop-Computer angeschlossen werden können. Weitere In-
formationen finden Sie im Thema „Installieren des Concurrent License Managers” auf Seite 2.

2. Lizenzieren Sie das Produkt. Mit diesem Vorgang erhält der Lizenzmanager die für die Ausgabe der
Lizenzen erforderlichen Informationen. Weitere Informationen finden Sie im Thema
„Produktlizenzierung” auf Seite 4.

3. Testen Sie den Concurrent License Manager. Sie sollten den Lizenzmanager testen, um sicherzustel-
len, dass er Lizenzen bereitstellt. Weitere Informationen finden Sie im Thema „Testen des
Lizenzmanagers” auf Seite 8.

4. Installieren Sie IBM SPSS Modeler auf den lokalen Desktop-Computern. Sie oder Ihre Endbenut-
zer führen die vollständige Installation auf den Desktop-Computern durch. Während der Installation
kann der Endbenutzer den Computer angeben, auf dem der Lizenzmanager ausgeführt wird. Wenn
ein Endbenutzer versucht, IBM SPSS Modeler zu starten, fordert das Produkt bei diesem Lizenzmana-
ger einen Lizenzcode an. Wenn eine Lizenz verfügbar ist, wird IBM SPSS Modeler gestartet. Weitere
Informationen finden Sie im Thema „Installieren des Produkts auf lokalen Desktop-Computern” auf
Seite 8.

Für die Installation sind keine administrativen Schritte erforderlich. Sollten jedoch Probleme auftreten,
finden Sie unter „Verwalten der Lizenz für gleichzeitig angemeldete Benutzer” auf Seite 11 weitere Infor-
mationen.

Citrix- und Terminaldienste
Sie können die Anwendung IBM SPSS Modeler auf dieselbe Art auf dem Citrix- bzw. Terminaldienst-Ser-
ver installieren und den Benutzern zugänglich machen, auf die Sie andere Anwendungen für Windows
installieren und zugänglich machen. Beachten Sie jedoch, dass der Lizenzmanager selbst nicht in einer
virtualisierten Umgebung installiert werden kann. Er muss auf einem physischen Computer installiert
werden.
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Gemischte Lizenzierung
IBM SPSS Modeler unterstützt gemischte Lizenzierungsumgebungen (eine Kombination aus lokalen Li-
zenzen für berechtigte Benutzer und Lizenzen für gleichzeitig angemeldete Benutzer) nur in einge-
schränktem Maße. In einer typischen Umgebung werden sämtliche Lizenzen entweder lokal oder über
den Concurrent License Manager verwaltet. Wenn das Hauptprodukt beispielsweise über den Concurrent
License Manager lizenziert ist, werden Optionen ebenfalls über den Concurrent License Manager lizen-
ziert.

Eine gemischte Lizenzierung ist nur möglich, wenn das Hauptprodukt über den Concurrent License Ma-
nager lizenziert und die Optionen auf dem Computer des Endbenutzers mit licenseactivator lizenziert wer-
den. Installieren Sie IBM SPSS Modeler mit einer Lizenz für gleichzeitig angemeldete Benutzer, um diese
Art der gemischten Lizenzierung einzurichten. Verwenden Sie dann licenseactivator auf dem Computer
des Endbenutzers, um die Optionen zu lizenzieren. Weitere Informationen zu licenseactivator finden Sie
unter „Verwenden von licenseactivator zur automatischen Installation einer Lizenz” auf Seite 6.

IBM SPSS Modeler unterstützt das umgekehrte Szenario nicht, bei dem das Hauptprodukt lokal und die
Optionen über den Concurrent License Manager lizenziert werden.

Installieren des Concurrent License Managers
Bevor Endbenutzer IBM SPSS Modeler auf ihrem Desktop-Computer installieren, müssen Sie den Concur-
rent License Manager installieren. Dieses Dienstprogramm ist ein fortlaufend ausgeführter Service oder
Dämonprozess, der üblicherweise auf einem Computer im Netz installiert wird. (Sie haben auch die Mög-
lichkeit, ihn auf mehreren Computern zu installieren, wobei Sie redundante Lizenzmanager einrichten
müssen. Weitere Informationen finden Sie im Thema „Einrichten von redundanten Lizenzservern” auf
Seite 12.) Der Concurrent License Manager wird nicht auf den Desktop-Computern installiert.

Immer wenn ein Endbenutzer eine der Lizenz für gleichzeitig angemeldete Benutzer unterliegende IBM
SPSS-Anwendung startet, fordert die Anwendung eine Lizenz vom Lizenzmanager an. Dieses Dienstpro-
gramm gibt Lizenzen bis zu einer festgelegten Anzahl gleichzeitiger Endbenutzer aus, die sich aus der
von Ihnen erworbenen Lizenz ergibt. Wenn diese Anzahl erreicht ist, werden weitere Anfragen nach Li-
zenzen zurückgewiesen. Wenn Sie feststellen, dass Endbenutzern häufig Lizenzen verweigert werden, er-
kundigen Sie sich bei dem für Sie zuständigen Händler nach einer Lizenz für eine größerer Anzahl
gleichzeitiger Benutzer.

Anmerkung: Sie müssen den Concurrent License Manager auf einem physischen Computer installieren.
Die Installation des Lizenzmanagers in einer virtualisierten Umgebung wird nicht unterstützt.

Anmerkung: Der Lizenzmanager zeichnet die Anzahl aktiver Endbenutzersitzungen sowie Informationen
zu diesen einzelnen Sitzungen in einer Protokolldatei auf, die Sie dann zur Fehlerbehebung bei Verbin-
dungsproblemen heranziehen können. Weitere Informationen finden Sie im Thema „Abrufen von
Protokollinformationen” auf Seite 12.

Mehrere Betriebssysteme

Die Plattform, auf der der Concurrent License Manager ausgeführt wird, muss nicht mit der Plattform
übereinstimmen, auf der der Client aktiv ist. Zum Beispiel kann ein Linux-Lizenzmanager Lizenzen für
Windows-Clients bereitstellen.

Verwalten des Lizenzmanagers

Der Lizenzmanager wird mithilfe des Lizenzmanageradministrators verwaltet, der nur für Windows ver-
fügbar ist. Beachten Sie deshalb, dass Sie mindestens einen Windows-System benötigen, auf dem der Li-
zenzmanageradministrator installiert ist.
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Systemanforderungen

Der Computer, auf dem der Concurrent License Manager installiert werden soll, muss folgende Anforde-
rungen erfüllen:
v Prozessor mit mindestens 500 Mhz
v Mindestens 128 MB RAM

Wichtig: Wenn auf dem Lizenzserver eine Firewall läuft, müssen Sie Port 5093 für UDP öffnen. Andern-
falls können die Client-Computer keine Lizenz vom Lizenzmanager abrufen. Wenn Sie darüber hinaus re-
dundante Lizenzserver verwenden, müssen Sie Port 5099 für UDP öffnen, damit die Lizenzserver unterei-
nander kommunizieren können.

Durchführen eines Upgrades für den Lizenzmanager
Wenn Sie eine frühere Version des Lizenzmanagers installiert haben, müssen Sie die folgenden Schritte
durchführen:
1. Wechseln Sie in das Verzeichnis, in dem Sie den alten Lizenzmanager installiert haben.
2. Kopieren Sie die Datei lservrc. Windows: Suchen Sie im Verzeichnis winnt.
3. Speichern Sie die Datei lservrc an einem sicheren Ort.
4. Falls Benutzer Pendlerlizenzen ausgecheckt haben, stellen Sie sicher, dass diese Lizenzen wieder ein-

gecheckt werden. Informationen zum Abrufen einer Liste der ausgecheckten Lizenzen finden Sie im
Thema „Konfigurieren von Pendlerlizenzen” auf Seite 14.

5. Fahren Sie den Lizenzmanager herunter. Weitere Informationen finden Sie im Thema „Starten und
Stoppen des Lizenzmanagers” auf Seite 17.

6. Deinstallieren Sie den alten Lizenzmanager. Weitere Informationen finden Sie im Thema „Deinstallie-
ren des Lizenzmanagers” auf Seite 17.

7. Installieren Sie den neuen Lizenzmanager. Informationen zum Installieren unter Windows finden Sie
im Thema „Installieren des Lizenzmanagers unter Windows”. Informationen zum Installieren unter
UNIX/Linux finden Sie im Thema „Installieren des Lizenzmanagers unter UNIX/Linux” auf Seite 4.

8. Kopieren Sie die gespeicherte Datei lservrc in das Verzeichnis, in dem Sie den neuen Lizenzmanager
oder das Unterverzeichnis winnt des Installationsverzeichnisses unter Windows installiert haben.
Wenn Sie den Standardspeicherort unter Windows akzeptiert haben, wechseln Sie in den Ordner C:\
Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\License Manager.

Installieren des Lizenzmanagers unter Windows

Anmerkung: Sie müssen Concurrent License Manager auf einem physischen Computer installieren. Die
Installation des Lizenzmanagers in einer virtualisierten Umgebung wird nicht unterstützt.

Anmerkung: Unter Windows Vista oder später müssen Sie das Installationsprogramm als Administrator
ausführen. Wenn Sie aufgefordert werden, eine Installationsdatei zu starten, klicken Sie mit der rechten
Maustaste auf die Datei und wählen Sie Als Administrator ausführen.

Anmerkung: Vergewissern Sie sich, dass auf dem Computer, auf dem Sie die Installation durchführen,
Java installiert ist.
1. Legen Sie die DVD mit den parallelen Lizenzierungstools in das DVD-Laufwerk des Netzcomputers

ein, auf dem der Lizenzmanager ausgeführt werden soll. Suchen Sie nach dem Windows Installer für
den Lizenzmanager und starten Sie ihn von der DVD.
ODER:
Wenn Sie eine eImage-Datei heruntergeladen haben, können Sie mit einem Archivierungsprogramm
wie WinZip alle Dateien im entsprechendem eImage extrahieren. Starten Sie die Datei des Installati-
onsprogramms für Ihr Betriebssystem.

2. Folgen Sie den am Bildschirm angezeigten Anweisungen.
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Installieren des Lizenzmanagers unter UNIX/Linux

Anmerkung: Sie müssen den Concurrent License Manager auf einem physischen Computer installieren.
Die Installation des Lizenzmanagers in einer virtualisierten Umgebung wird nicht unterstützt.
1. Legen Sie die DVD mit den parallelen Lizenzierungstools in das DVD-Laufwerk des Netzcomputers

ein, auf dem der Lizenzmanager ausgeführt werden soll. Suchen Sie nach der Lizenzmanagerdatei für
Ihr Betriebssystem.
ODER:
Wenn Sie eine eImage-Datei heruntergeladen haben, wechseln Sie zu dem Speicherort, an den Sie die
Datei heruntergeladen haben.

2. Entpacken Sie die Datei des Lizenzmanagers.
3. Führen Sie die extrahierte TAR-Datei aus.
4. Folgen Sie den am Bildschirm angezeigten Anweisungen.
5. Installieren Sie den Lizenzmanageradministrator auf einem Windows-System. Weitere Informationen

finden Sie im Thema „Installieren des Lizenzmanageradministrators”.
6. Weitere Informationen zum Starten des Lizenzmanagers finden Sie unter „Starten und Stoppen des

Lizenzmanagers” auf Seite 17.

Installieren des Lizenzmanageradministrators
Der nur für Windows verfügbare Lizenzmanageradministrator wird für die Verwaltung des Lizenzmana-
gers verwendet. Je nach Betriebssystem müssen Sie diese Anwendung gegebenenfalls manuell installieren.
v Windows. Der Lizenzmanageradministrator wird automatisch auf dem gleichen System installiert, auf

dem Sie auch den Lizenzmanager installiert haben. Sie können die Installation auch auf einem anderen
Windows-System vornehmen, wenn Sie den Lizenzmanager remote verwalten möchten.

v Andere Betriebssysteme. Wenn Sie den Lizenzmanager auf einem Nicht-Windows-System installiert
haben, müssen Sie die Lizenzmanagertools auf einem Windows-System installieren.

1. Legen Sie die DVD mit den parallelen Lizenzierungstools in das DVD-Laufwerk des Netzcomputers
ein, auf dem der Lizenzmanageradministrator ausgeführt werden soll. Suchen Sie nach dem Windows
Installer für den Lizenzmanageradministrator und starten Sie ihn von der DVD.
ODER:
Wenn Sie eine eImage-Datei heruntergeladen haben, können Sie mit einem Archivierungsprogramm
wie WinZip alle Dateien im entsprechendem eImage extrahieren. Starten Sie die Installationsdatei des
Lizenzmanageradministrators.

2. Folgen Sie den am Bildschirm angezeigten Anweisungen.

Produktlizenzierung
Klicken Sie nach dem Abschluss des Hauptteils der Installation auf Fertigstellen, um den Lizenzautorisie-
rungsassistenten zu starten. Mit dem Lizenzautorisierungsassistenten können Sie eine Lizenz für IBM
SPSS Modeler anfordern. Bei anderen Betriebssystemen müssen Sie die Lizenz nach der Installation des
Lizenzmanagers über die Eingabeaufforderung installieren.

Wenn Sie jetzt keine Lizenz beziehen, können Sie IBM SPSS Modeler für einen bestimmten Zeitraum für
die temporäre Verwendung aktivieren, in dem das Produkt von einer begrenzten Anzahl an Personen
verwendet werden kann. Alle Optionen sind aktiviert. Nach Ablauf des Zeitraums für die temporäre Ver-
wendung, der mit der ersten Nutzung des Produkts beginnt, kann IBM SPSS Modeler nicht mehr ausge-
führt werden. Daher sollten Sie so schnell wie möglich einen Lizenzcode anfordern. Sie müssen entweder
eine Lizenz einholen oder eine Aktivierung für die temporäre Verwendung durchführen, um IBM SPSS
Modeler zu verwenden.
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Anmerkung: Lizenzen sind mit einem Sperrcode an die Hardware des Netzcomputers gebunden. Wenn
Sie den Netzcomputer oder die zugehörige Hardware austauschen, benötigen Sie einen neuen Sperrcode
und müssen bei Ihrem Vertriebsbeauftragten einen neuen Autorisierungscode anfordern. Wenn Sie die in
der Lizenzvereinbarung angegebene zulässige Anzahl an Autorisierungen überschritten haben, rufen Sie
die Seite http://www.ibm.com/software/analytics/spss/support/clientcare.html auf, um Unterstützung
durch das Kundenbetreuungsteam anzufordern. Beachten Sie auch, dass Ihr Autorisierungscode für eine
bestimmte Anzahl an CPUs generiert wurde. Wenn Sie über eine größere Anzahl an CPUs als im Autori-
sierungscode angegeben verfügen, erhalten Sie eine Warnnachricht und das Produkt funktioniert 30 Tage
nach der Autorisierung nicht mehr.

Wichtig: Die Lizenz reagiert auf Änderungen der Systemzeit. Wenn Sie die Systemzeit ändern müssen
und dann das Produkt nicht mehr ausführen können, fordern Sie Unterstützung durch das Kunden-
betreuungsteam über die Seite http://www.ibm.com/software/analytics/spss/support/clientcare.html
an.

Verwenden des Lizenzautorisierungsassistenten (nur Windows)
Hinweis: Wenn Sie Windows Vista oder eine höhere Version verwenden, werden Sie gegebenenfalls aufge-
fordert, sich als Administrator anzumelden. Ohne die entsprechenden Berechtigungsnachweise können
Sie den Lizenzautorisierungsassistenten nicht ausführen.
1. Wenn Sie den Lizenzautorisierungsassistenten nicht während der Installation starten oder den Lizenz-

autorisierungsassistenten abbrechen, bevor eine Lizenz erworben wurde, können Sie ihn durch Aus-
führung der Datei law.exe starten, die Sie im Installationsverzeichnis des Lizenzmanagers finden. Un-
ter Windows Vista oder später muss die Ausführung durch einen Administratorrechte erfolgen.
Klicken Sie mit der rechten Maustaste auf die Datei law.exe und wählen Sie Als Administrator aus-
führen aus.

2. Wenn Sie dazu aufgefordert werden, wählen Sie Mein Produkt jetzt lizenzieren aus. Wenn Sie statt-
dessen eine Aktivierung für die temporäre Verwendung durchführen möchten, finden Sie unter „Akti-
vieren für die temporäre Verwendung” auf Seite 7 weitere Informationen.

3. Geben Sie an der entsprechenden Eingabeaufforderung mindestens einen Autorisierungscode ein.
Sie sollten separate Anweisungen zum Abrufen Ihres Autorisierungscode erhalten haben. Wenn Sie Ih-
ren Autorisierungscode nicht finden können, wenden Sie sich an den Kundendienst, indem Sie die
Website http://www.ibm.com/software/analytics/spss/support/clientcare.html aufrufen.

Der Lizenzautorisierungsassistent sendet Ihren Autorisierungscode über das Internet an IBM und ruft
Ihre Lizenz automatisch ab. Wenn sich Ihr Computer hinter einem Proxy befindet, klicken Sie auf Proxy-
Einstellungen konfigurieren und geben Sie die entsprechenden Einstellungen an.

Wenn der Autorisierungsprozess fehlschlägt, werden Sie aufgefordert, eine E-Mail-Nachricht zu senden.
Wählen Sie aus, ob die E-Mail-Nachricht über Ihr Desktop-E-Mail-Programm oder über eine webbasierte
E-Mail-Anwendung versendet werden soll.
v Wenn Sie die Desktopoption auswählen, wird automatisch eine neue Nachricht mit den entsprechen-

den Informationen erstellt.
v Wenn Sie die webbasierte Option auswählen, müssen Sie zuerst eine neue Nachricht in Ihrem Web-

basierten E-Mail-Programm erstellen. Kopieren Sie dann den Nachrichtentext aus dem Lizenzautorisie-
rungsassistenten und fügen Sie ihn in Ihre E-Mail-Anwendung ein.

Senden Sie die E-Mail-Nachricht und befolgen Sie die Eingabeaufforderung des Lizenzautorisierungsassis-
tenten. Die E-Mail-Nachricht wird unmittelbar verarbeitet. Empfangene Lizenzcodes können Sie eingeben,
indem Sie auf Code eingeben klicken. Wenn Sie den Lizenzautorisierungsassistenten bereits geschlossen
haben, starten Sie ihn erneut und wählen Sie die Option Mein Produkt jetzt lizenzieren aus. Fügen Sie
im Bereich "Codes eingeben" den erhaltenen Lizenzcode hinzu und klicken Sie auf Weiter, um den Vor-
gang abzuschließen.
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Installieren einer Lizenz über die Eingabeaufforderung

Sie haben zwei Möglichkeiten zur Installation über die Eingabeaufforderung. Sie können mithilfe von li-
censeactivator automatisch eine Lizenz aus dem Internet abrufen oder Sie können mithilfe von echoid
manuell eine Lizenz beziehen.

Verwenden von licenseactivator zur automatischen Installation einer Lizenz
Der Computer, auf dem Sie die Lizenz installieren, muss mit dem Internet verbunden sein. Andernfalls
müssen Sie die Lizenz manuell installieren. Weitere Informationen finden Sie im Thema „Manuelles Ins-
tallieren einer Lizenz” auf Seite 7.
1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.
2. Öffnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-

nagers. Dies ist das Verzeichnis, in dem Sie den Lizenzmanager installiert haben, nicht das Installations-
verzeichnis von IBM SPSS Modeler. Wenn Sie den Standardspeicherort unter Windows akzeptiert ha-
ben, wechseln Sie in den Ordner C:\Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\
License Manager.

3. Nur unter Windows. Wechseln Sie in das Unterverzeichnis winnt.
4. Normalerweise sind Sie im Besitz eines Autorisierungscodes. Im einfachsten Fall geben Sie Folgendes

an der Eingabeaufforderung ein. (Weitere Details zur Verwendung der Befehlszeile finden Sie unten.)
licenseactivator <Autorisierungscode>

Dabei ist <Autorisierungscode> Ihr Autorisierungscode.

Es sollte eine Nachricht angezeigt werden, dass die Lizenz erfolgreich hinzugefügt wurde. Andernfalls
notieren Sie sich den Fehlercode und versuchen Sie, die Lizenz manuell zu installieren. Weitere Informati-
onen finden Sie im Thema „Manuelles Installieren einer Lizenz” auf Seite 7.

Bei Verwendung von licenseactivator wird das Produkt lizenziert und eine Protokolldatei in das Pro-
duktverzeichnis geschrieben. Der Name der Protokolldatei ist licenseactivator_<Monat>_<Tag>_<Jahr>.log.
Wenn Fehler auftreten, können Sie gegebenenfalls der Protokolldatei weitere Informationen entnehmen.
Diese Informationen sind auch dann hilfreich, wenn Sie sich an den IBM Support wenden.

Verwenden von licenseactivator mit Autorisierungscodes

licenseactivator wird üblicherweise mit einem oder mehreren Autorisierungscodes verwendet, die Sie beim
Kauf des Produkts erhalten haben. Geben Sie den gesamten Text in einer einzigen Zeile ein.
licenseactivator Autorisierungscode1[:Autorisierungscode2:...:AutorisierungscodeN] [PROXYHOST=Proxy-Hostname]
[PROXYPORT=Proxy-Portnummer] [PROXYUSER=Proxy-Benutzer-ID] [PROXYPASS=Proxy-Kennwort]

v Mehrere Autorisierungscodes werden durch Doppelpunkte (:) getrennt.
v Die Proxy-Einstellungen sind optional, aber sie sind unter Umständen nötig, wenn sich Ihr Computer

hinter einem Proxy befindet. Welche Proxy-Einstellungen benötigt werden, hängt von der jeweiligen
Proxy-Konfiguration ab. Möglicherweise sind alle erforderlich.

PROXYHOST
Der Servername oder die IP-Adresse des Proxy-Hosts

PROXYPORT
Die Portnummer für die Internetverbindung über den Proxy

PROXYUSER
Falls erforderlich, die Benutzer-ID für den Proxy.

PROXYPASS
Falls erforderlich, das Kennwort für die Benutzer-ID
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Verwenden von licenseactivator mit Lizenzcodes

Eventuell hat Ihnen IBM eine Lizenz gesendet.
licenseactivator Lizenzcode[:Lizenzcode2:...:LizenzcodeN]

v Mehrere Lizenzcodes werden durch Doppelpunkte (:) getrennt.
v Bei Verwendung von Lizenzcodes stellt licenseactivator keine Verbindung zum Internet her, sodass Sie

keine Proxy-Informationen angeben müssen.

Manuelles Installieren einer Lizenz
1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.
2. Öffnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-

nagers. Beachten Sie, dass dies der Ordner ist, in dem Sie den Lizenzmanager installiert haben, nicht
das Installationsverzeichnis von IBM SPSS Modeler. Wenn Sie den Standardspeicherort unter Win-
dows akzeptiert haben, wechseln Sie in den Ordner C:\Programme\IBM\SPSS\Concurrent Licensing
Tools\<Version>\License Manager.

3. Nur unter Windows. Wechseln Sie in das Unterverzeichnis winnt.
4. Rufen Sie den Sperrcode für den Server-Computer ab. Geben Sie an der Eingabeaufforderung echoid

(Windows) oder ./echoid (andere Plattformen) ein.
5. Rufen Sie unsere regionale Niederlassung an oder senden Sie eine E-Mail an spsscs@us.ibm.com und

teilen Sie IBM den Sperrcode und Ihren Autorisierungscode mit. IBM wird Ihnen anschließend einen
Lizenzcode oder eine Datei mit dem Lizenzcode bereitstellen.

6. Verwenden Sie licenseactivator zur Eingabe des bzw. der Lizenzcodes.

Aktivieren für die temporäre Verwendung
Wenn Sie die Lizenz nicht installiert haben, können Sie IBM SPSS Modeler für die temporäre Verwen-
dung aktivieren.
1. Wenn Sie über Installationsdatenträger verfügen, stellen Sie sicher, dass sich die DVD im DVD-Lauf-

werk befindet. Wenn Sie ein eImage heruntergeladen haben, öffnen und/oder extrahieren Sie den In-
halt des eImage.

2. Starten Sie die Anwendung WlmAdmin. Weitere Informationen finden Sie im Thema „Starten der An-
wendung WlmAdmin” auf Seite 11.

3. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben Subnet
Servers. Wenn der Lizenzmanagerserver nicht angezeigt wird, geben Sie den Computer an, indem Sie
im Menü "Edit" die Option Defined Server List auswählen.

4. Klicken Sie mit der rechten Maustaste auf den Netzcomputer, auf dem der Lizenzmanager ausgeführt
wird, und wählen Sie dann die folgenden Befehle aus:
Add Feature > From a File > To Server and its File

Hinweis: Wenn Sie To Server auswählen anstatt To Server and its File, werden die Informationen zur
temporären Verwendung im Arbeitsspeicher gespeichert. Diese Informationen gehen beim Neustart
des Netzcomputers verloren.

5. Geben Sie im Dialogfeld "Open" den Pfad D:\Sentinel\LicenseManager\lservrc.temp ein. Dabei steht
D für das Laufwerk Ihres Installationsdatenträgers. Wenn D nicht das Laufwerk Ihres Installationsda-
tenträgers ist, geben Sie den entsprechenden Laufwerkbuchstaben ein.

6. Klicken Sie auf OK, wenn die Anwendung Ihre Lizenz anzeigt. Informationen zur Anzeige der Li-
zenzdetails finden Sie unter „Anzeigen der Details zu einer Lizenz” auf Seite 12.

Hinzufügen einer Lizenz
Eventuell möchten Sie zu einem späteren Zeitpunkt eine Lizenz hinzufügen. Der Vorgang beim Hinzufü-
gen einer Lizenz ist identisch mit der Installation der originalen Lizenz.
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Anzeigen der Lizenz
Sie können Ihre Lizenz für gleichzeitig angemeldete Benutzer (einschließlich der Anzahl der Benutzer) in
der Anwendung WlmAdmin anzeigen. Informationen zur Anwendung WlmAdmin und die Besonderhei-
ten beim Anzeigen der Lizenz finden Sie unter „Verwalten der Lizenz für gleichzeitig angemeldete
Benutzer” auf Seite 11.

Testen des Lizenzmanagers
Um sicherzustellen, dass der Lizenzmanager die Lizenzen korrekt bereitstellt, sollten Sie ihn testen.
1. Wenn Sie den Lizenzmanageradministrator nicht auf einem anderen System installiert haben, installie-

ren Sie ihn auf einem Windows-System, auf dem der Lizenzmanager, den Sie testen möchten, nicht
läuft. Weitere Informationen finden Sie im Thema „Installieren des Lizenzmanageradministrators” auf
Seite 4.

2. Installieren Sie einen weiteren Lizenzmanager auf einem Windows-System, auf dem der Lizenzmana-
ger, den Sie testen möchten, nicht ausgeführt wird. Weitere Informationen finden Sie im Thema „Ins-
tallieren des Lizenzmanagers unter Windows” auf Seite 3.

3. Starten Sie die Anwendung WlmAdmin. Weitere Informationen finden Sie im Thema „Starten der An-
wendung WlmAdmin” auf Seite 11.

4. Fügen Sie den fernen Server des Lizenzmanagers hinzu, den Sie testen möchten. Weitere Informatio-
nen finden Sie im Thema „Hinzufügen eines Servers” auf Seite 11.

5. Zeigen Sie die Lizenzen auf dem fernen Server an. Weitere Informationen finden Sie im Thema „An-
zeigen der Details zu einer Lizenz” auf Seite 12.

Wenn Sie die Lizenzen anzeigen können, ist der Lizenzmanager bereit, dass lokale Desktop-Computer an-
geschlossen werden. Sie können mit der Installation des Produkts auf lokalen Desktop-Computern begin-
nen. Wenn Sie die Lizenzen nicht anzeigen können, überprüfen Sie die vorhergehenden Schritte, um si-
cherzustellen, dass der Lizenzmanager korrekt installiert wurde.

Installieren des Produkts auf lokalen Desktop-Computern

Anmerkung: Die Verbindung mit dem Concurrent License Manager über VPN wird nicht offiziell unter-
stützt.

Für die lokale Installation des vollständigen Produkts auf den Computern der Endbenutzer stehen Ihnen
zwei Optionen zur Verfügung: Sie können auf jedem Computer eine manuelle Installation durchführen
oder eine Anwendung wie Systems Management Server (SMS) verwenden, um die Installation auf Win-
dows-Computern durchzuführen.

Durchführen einer manuellen Installation auf einem lokalen Desktop-Computer
1. Stellen Sie die Installationsmedien zur Verfügung. Laden Sie das eImage für das Produkt herunter

und extrahieren Sie die Dateien auf einem freigegebenen Netzlaufwerk. Wenn Sie über Installationsda-
tenträger verfügen, erstellen Sie die benötigte Anzahl von Kopien der DVD oder speichern Sie die
entsprechenden Dateien auf einem freigegebenen Netzlaufwerk.

2. Kopieren Sie die Installationsanweisungen und bereiten Sie die Lizenzinformationen vor. Erstellen
Sie die benötigte Anzahl von Kopien der Installationsanweisungen für das Produkt. Die Installations-
anweisungen stehen auf der Download-Site bzw. im Falle von physischen Installationsmedien im Ver-
zeichnis Documentation\<Sprache>\Installationauf der DVD zur Verfügung. Suchen Sie nach den An-
weisungen, die Ihrem Lizenztyp entsprechen. Nach der Installation müssen die Endbenutzer die IP-
Adresse oder den Namen des Netzcomputers eingeben, auf dem der Concurrent License Manager
ausgeführt wird. Tragen Sie diese Informationen an der dafür vorgesehenen Stelle am Anfang der An-
weisungen ein, bevor Sie diese kopieren.
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3. Verteilen Sie die Installationsunterlagen und -medien an die Endbenutzer. Verteilen Sie die Installa-
tions-DVDs ( oder geben Sie den Netzpfad des Installationsdatenträgers bekannt), die Installationsan-
weisungen und die Lizenzinformationen an die Endbenutzer, die auf den Computern nach Bedarf ma-
nuell installieren können.

Übertragen der Installation unter Windows auf lokale Desktop-Computer

Da IBM SPSS Modeler-Installationen mit Microsoft Windows Installer (MSI) kompatibel sind, können Sie
die Installation automatisch auf die Desktop-Computer der Endbenutzer übertragen.

Übertragen einer Installation an Windows-Computer
Das Übertragen einer Installation ist eine Methode für die Fernverteilung von Software an eine beliebige
Zahl von Endbenutzern, ohne dass die Benutzer aktiv werden müssen. Sie können eine vollständige Ins-
tallation von IBM SPSS Modeler auf die Computer der Endbenutzer unter Windows übertragen. Die für
die automatische Übertragung der Installation verwendete Technologie muss die MSI 3,0-Engine oder hö-
her unterstützen.

Deinstallation einer früheren Version
Wenn Sie die automatische Übertragung in ein Verzeichnis durchführen, in dem eine frühere Version von
IBM SPSS Modeler installiert wurde, muss die alte Version deinstalliert werden. Sie müssen IBM SPSS
Modeler-Versionen vor 11.0 manuell entfernen, da Push-Installationen für diese Versionen nicht verfügbar
waren.Sie können die Deinstallation ebenso wie eine Installation übertragen. Weitere Informationen fin-
den Sie im Thema „Automatische Übertragung einer Deinstallation” auf Seite 11.

Eigenschaften für automatisch übertragene Installationen
Nachfolgend finden Sie die Eigenschaften, die für automatisch übertragene Installationen verwendet wer-
den können. Bei allen Eigenschaften wird zwischen Groß- und Kleinschreibung unterschieden. Werte
müssen in Anführungszeichen angegeben werden, wenn sie Leerzeichen enthalten.

Tabelle 1. Eigenschaften für automatisch übertragene Installationen.

Eigenschaft Beschreibung Gültige(r) Wert(e)

INSTALLDIR Das Verzeichnis, in dem IBM SPSS
Modeler auf dem Desktop-Computer
des Endbenutzers installiert werden
sollte. Diese Eigenschaft ist optional.
Wird sie nicht angegeben, wird der
Standardwert C:\Programme\IBM\
SPSS\Modeler\16 verwendet.

Ein gültiger Pfad, beispielsweise C:\
Programme\IBM\SPSS\Modeler\16.

LICENSETYPE Der Lizenztyp. Bei diesem Wert wird
zwischen Groß- und Kleinschreibung
unterschieden.

Network

LSHOST Die IP-Adresse oder der Name des
Computers bzw. der Computer im
Netz, auf dem bzw. denen der
Concurrent License Manager ausge-
führt wird.

Eine oder mehrere gültige IP-Adres-
sen oder Namen der Computer im
Netz. Mehrere Adressen oder Namen
müssen durch Doppelpunkte ge-
trennt werden (z. B.
Server:Server2:Server3).
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Tabelle 1. Eigenschaften für automatisch übertragene Installationen (Forts.).

Eigenschaft Beschreibung Gültige(r) Wert(e)

DISABLE_COMMUTE Inaktiviert die Pendlerlizenzfunktion
auf dem Desktop-Computer des
Endbenutzers. Wenn diese Eigen-
schaft angegeben wird, werden auf
dem Desktop-Computer keine Ver-
knüpfungen für Pendlerlizenzen ins-
talliert. Weitere Informationen zu
Pendlerlizenzen finden Sie unter
„Konfigurieren von Pendlerlizenzen”
auf Seite 14.

1 gibt an, dass die Pendlerlizenzen
inaktiviert sind.

COMMUTE_MAX_LIFE Die maximale Anzahl von Tagen, für
die ein Endbenutzer eine
Pendlerlizenz auschecken kann. Wei-
tere Informationen finden Sie im The-
ma „Konfigurieren von
Pendlerlizenzen” auf Seite 14.

Eine Zahl zwischen 1 und 30.

COMPANYNAME Der Name Ihres Unternehmens. Eine beliebige Zeichenfolge.

MSI-Dateien
Die Datei befindet sich im Verzeichnis modeler\<Architektur> auf der DVD, wobei <Architektur> für 32bit
oder 64bit steht. Wenn Sie die Software heruntergeladen haben, müssen Sie den Inhalt des eImage entpa-
cken, um auf die MSI-Datei zugreifen zu können.

Beispiel für die Befehlszeile
Nachfolgend finden Sie eine Befehlszeile zur automatischen Übertragung einer Produktinstallation. Geben
Sie den gesamten Text in einer einzigen Zeile ein.
MsiExec.exe /i "modelerclient.msi" /qn /L*v logfile.txt
INSTALLDIR="C:\Programme\IBM\SPSS\Modeler\16" LICENSETYPE="Network" LSHOST="mylicserver"

Automatisches Übertragen der Installation mithilfe von SMS
Die grundlegenden Schritte für die Verwendung von Systems Management Servers (SMS) für die automa-
tische Übertragung (Push) von IBM SPSS Modeler sind folgende:
1. Kopieren Sie das entsprechende Unterverzeichnis im Verzeichnis modeler\<Architektur> auf der DVD

in ein Verzeichnis auf einem Netzcomputer. Wenn Sie die Software heruntergeladen haben, müssen
Sie den Inhalt des eImage zunächst entpacken.

2. Bearbeiten Sie die Datei .pdf im kopierten Verzeichnis. Bearbeiten Sie mithilfe eines Texteditors den
Wert von "CommandLine", indem Sie die entsprechenden Eigenschaften hinzufügen. Eine Liste der
verfügbaren Eigenschaften finden Sie unter „Eigenschaften für automatisch übertragene
Installationen” auf Seite 9. Stellen Sie sicher, dass Sie die richtige MSI-Datei in der Befehlszeile ange-
ben.

3. Erstellen Sie ein Paket aus der Datei .pdf und verteilen Sie das Paket an die Desktop-Computer der
Endbenutzer.

Verwenden von Gruppenrichtlinie oder einer ähnlichen Technologie zur automati-
schen Übertragung der Installation
1. Kopieren Sie das entsprechende Unterverzeichnis im Verzeichnis modeler\<architecture> auf der DVD

in ein Verzeichnis auf einem Netzcomputer. Wenn Sie die Software heruntergeladen haben, müssen
Sie den Inhalt des eImage zunächst entpacken.

2. Mit einer Anwendung wie ORCA können Sie die Eigenschaftstabelle in der entsprechenden Datei un-
ter dem kopierten Ordner bearbeiten. ORCA ist Teil des Windows 2003 Server SDK, das Sie unter
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http://www.microsoft.com/downloads finden, indem Sie nach dem SDK suchen. Eine Liste der Ei-
genschaften, die in die Eigenschaftstabelle aufgenommen werden können, finden Sie unter „Eigen-
schaften für automatisch übertragene Installationen” auf Seite 9. Achten Sie darauf, dass Sie die richti-
ge MSI-Datei verwenden.

3. Erstellen Sie ein Paket aus der bearbeiteten Datei und verteilen Sie das Paket an die Desktop-Compu-
ter der Endbenutzer.

Automatische Übertragung einer Deinstallation
Hinweis: Wenn Sie den Deinstallationsbefehl automatisch übertragen, gehen die Anpassungen der Endbe-
nutzer verloren. Wenn bestimmte Benutzer ihre Anpassungen benötigen, können Sie diese aus der Vertei-
lung ausschließen und sie bitten, das Produkt manuell zu installieren.

Wenn Sie eine Installation einer neueren Version von IBM SPSS Modeler automatisch übertragen, sollten
Sie gegebenenfalls zuerst eine Deinstallation durchführen. Sie können dies im Hintergrund durchführen
lassen, indem Sie den folgenden Befehl durch einen Push-Vorgang automatisch übertragen. Geben Sie den
gesamten Text in einer Zeile ein.
MsiExec.exe /X{} /qn /L*v logfile.txt
ALLUSERS=1 REMOVE="ALL"

Den Produktcode für eine bestimmte Version finden Sie in der Datei setup.ini in den installierten Ordnern
der betreffenden Version.

Verwalten der Lizenz für gleichzeitig angemeldete Benutzer
Der Lizenzmanager verwaltet die Lizenz für gleichzeitig angemeldete Benutzer. Mithilfe der Anwendung
WlmAdmin, die die Hauptbenutzerschnittstelle für den Lizenzmanageradministrator ist, können Sie den
Lizenzmanager verwalten und Informationen zu den verwalteten Lizenzen für gleichzeitig angemeldete
Benutzer anzeigen. Der Lizenzmanageradministrator wird unter Windows automatisch zusammen mit
dem Concurrent License Manager installiert. Wenn Sie einen Lizenzmanager auf einem Nicht-Windows-
System oder einem Remote-Windows-System verwalten, installieren Sie den Lizenzmanageradministrator
auf einem separaten Windows-System. Weitere Informationen finden Sie im Thema „Installieren des
Lizenzmanageradministrators” auf Seite 4.

Hinweis: Weitere Informationen zur Administration finden Sie in der SafeNet-Dokumentation, die zusam-
men mit dem Lizenzmanageradministrator installiert wird. Diese Dokumentation finden Sie im Unterver-
zeichnis Content des Installationsverzeichnisses des Lizenzmanageradministrators (z. B.C:\Programme\
IBM\SPSS\Concurrent Licensing Tools\9.5.0\License Manager Administrator\Content).

Starten der Anwendung WlmAdmin
Auf einem Windows-Computer, auf dem der Lizenzmanager installiert ist:
1. Wählen Sie folgende Befehle aus dem Menü "Start" von Windows aus: [Alle] Programme > IBM

SPSS Concurrent Licensing Tools - License Manager<Version> > Sentinel RMS License Server Ad-
ministration

Auf einem Windows-Computer, auf dem die Tools für den Lizenzmanager installiert sind:
1. Wählen Sie folgende Befehle aus dem Menü "Start" von Windows aus: [Alle] Programme > IBM

SPSS Concurrent Licensing Tools - License Manager Administrator <Version> > Sentinel RMS Li-
cense Server Administration

Hinzufügen eines Servers
Bevor Sie einen Lizenzmanager verwalten können, müssen Sie in der Anwendung WlmAdmin einen Ser-
ver dafür hinzufügen. Sie haben zwei Optionen, um den Server hinzuzufügen.
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Manuelles Hinzufügen eines Servers
1. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung WlmAdmin aus:

Edit > Defined Server List

2. Geben Sie in dem Dialogfeld "Defined Server List" den Namen oder die IP-Adresse des Servers ein,
auf dem der Lizenzmanager läuft.

3. Klicken Sie auf Add.
4. Klicken Sie auf OK.

Der Server wird jetzt in den Listen der Server im linken Fensterbereich der Anwendung WlmAdmin an-
gezeigt.

Anzeigen einer Liste der Server im Teilnetz
1. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben Subnet

Servers.

Eine Liste von Servern für Lizenzmanager in Ihrem Teilnetz wird angezeigt. Wenn Sie einen bestimmten
Server mit diesem Verfahren nicht finden, fügen Sie ihn wie oben beschrieben manuell hinzu.

Abrufen von Protokollinformationen
Wenn Endbenutzer beim Abruf von Lizenzen Schwierigkeiten haben, können die Protokolldateien mögli-
cherweise hilfreiche Informationen enthalten. Sie können die Umgebungsvariable LSERVOPTS sowie die
Optionen -f <Traceprotokolldatei> und -l <Nutzungsprotokolldatei> verwenden, um anzugeben, dass
Protokolldateien erstellt werden sollen. Weitere Informationen zu dieser Umgebungsvariablen und den
zugehörigen Optionen finden Sie in der SafeNet-Dokumentation im Verzeichnis Content des Installations-
verzeichnisses des Lizenzmanageradministrators.

Anzeigen der Details zu einer Lizenz
Sie können Details zu Lizenzen anzeigen, die Sie entweder manuell oder über den Lizenzierungsassisten-
ten hinzugefügt haben.
1. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben Lizenzma-

nagerserver, um die Lizenz(en) anzuzeigen.
2. Klicken Sie auf den Namen der Lizenz. Im rechten Fensterbereich werden Details zu der Lizenz ange-

zeigt. Die Lizenzen werden mithilfe von Codes identifiziert. Der erste Teil des Codes verweist auf die
Funktion. Der zweite Teil verweist auf die Version.

Anzeigen der mit den Funktionscodes verknüpften Namen
1. Wechseln Sie über eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-

nistrators.
2. Geben Sie lmshowlic <Server> (Windows) oder ./lmshowlic <Server> (andere Betriebssysteme) ein.

Dabei stellt <Server> den Namen oder die IP-Adresse des Servers dar, auf der Lizenzmanager ausge-
führt wird.

In der Ausgabe werden alle Funktionen nach Produkt und Version in Gruppen geordnet aufgeführt, die
auf dem Server verfügbar sind.

Einrichten von redundanten Lizenzservern
Sie können mehrere redundante Lizenzserver einrichten, die dieselben Benutzer unterstützen. Mit redun-
danten Servern können Sie Unterbrechungen verhindern, die durch den Absturz eines Servers bedingt
sind. Im Falle eines Serverabsturzes kann ein anderer redundanter Server die Lizenzverwaltung überneh-
men.
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Zum Aktivieren der Redundanzfunktion benötigen Sie wie in den folgenden Schritten beschrieben einen
speziellen Lizenzcode. Wenden Sie sich telefonisch oder per E-Mail an den IBM Support, wenn Sie Unter-
stützung beim Erstellen eines redundanten Lizenzschlüssels benötigen oder andere Lizenzierungsproble-
me auftreten. Sie finden die Kontaktdaten unter http://www.ibm.com/planetwide/de.

Es muss eine ungerade Anzahl von Servern (mindestens drei) vorhanden sein und die Mehrzahl der Ser-
ver muss jeweils gleichzeitig ausgeführt werden. Wenn zum Beispiel drei redundante Lizenzserver exis-
tieren, müssen von diesen zwei ausgeführt werden.

Vorbereiten der einzelnen redundanten Lizenzserver
1. Installieren Sie den Lizenzmanager. Weitere Informationen finden Sie im Thema „Installieren des Con-

current License Managers” auf Seite 2.
2. Wechseln Sie über eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
3. Rufen Sie den Sperrcode für die einzelnen Server-Computer ab. Geben Sie an der Eingabeaufforde-

rung echoid (Windows) bzw. ./echoid (anderes Betriebssystem) ein.
4. Notieren Sie den Sperrcode. Sie benötigen den Sperrcode für die nächsten Schritte.
5. Wiederholen Sie diese Schritte für jeden redundanten Lizenzserver.

Aktivieren der redundanten Lizenzen
1. Rufen Sie das IBM SPSS License Key Center (https://spss.subscribenet.com/control/ibmp/login) auf.
2. Erstellen Sie einen Autorisierungscode für den gleichzeitigen Zugriff durch mehrere Nutzer.
3. Nach der Erstellung des Autorisierungscodes für den gleichzeitigen Zugriff durch mehrere Nutzer kli-

cken Sie auf den Code und blättern nach unten, bis Sie die Felder für den Sperrcode sehen. Sie kön-
nen dem Lizenzschlüssel jetzt mehrere Sperrcodes hinzufügen.

4. Geben Sie die in den vorherigen Schritten erstellten Sperrcodes in die entsprechenden Felder ein.
5. Klicken Sie auf Submit.

Einrichten eines Pools mit redundanten Lizenzservern
1. Wenn auf einem oder mehreren redundanten Lizenzservern ein Lizenzmanager ausgeführt wird, be-

enden Sie diesen auf jedem betroffenen Computer.
2. Wählen Sie in den WlmAdmin-Anwendungsmenüs Folgendes aus:

Edit > Redundant License File

Dadurch wird die Anwendung WrlfTool geöffnet.
3. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung WrlfTool aus:

File > New

4. Klicken Sie für jeden redundanten Lizenzserver auf Add, um jeweils den Hostnamen und die IP-Ad-
resse anzugeben.

5. Ordnen Sie die redundanten Lizenzserver in der Reihenfolge an, in der sie verwendet werden sollen.
Der erste Server in der Liste ist der primäre Server.

6. Klicken Sie auf Add License, um die Lizenzen hinzuzufügen, die Sie vom Kundendienst oder Ihrer
lokalen Niederlassung erhalten haben. Achten Sie bei mehreren Lizenzen darauf, dass Sie auch wirk-
lich alle hinzugefügt haben.

7. Klicken Sie auf OK.
8. Klicken Sie abschließend auf Done.

Speichern der redundanten Lizenzdatei
1. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung WrlfTool aus:

File > Save As

2. Speichern Sie die redundante Lizenzdatei (lservrlf) an einem leicht zugänglichen Speicherort. In den
nächsten Schritten müssen Sie die Datei kopieren.
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Konfigurieren der redundanten Lizenzserver
1. Kopieren Sie die redundante Lizenzdatei (lservrlf) unter Windows in den Unterordner winnt des Li-

zenzmanagerinstallationsverzeichnisses. Wenn Sie den Standardspeicherort akzeptiert haben, wechseln
Sie in den Ordner C:\Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\License Manager.
Auf anderen Betriebssystemen kopieren Sie die Datei direkt in das Lizenzmanagerinstallationsver-
zeichnis. Es müssen mindestens drei redundante Lizenzserver vorhanden sein.

2. Starten Sie auf allen redundanten Lizenzservern den Lizenzmanager.

Konfigurieren des Computers des Endbenutzers

Wenn ein Endbenutzer das Produkt installiert, gibt der Benutzer alle redundanten Server an. Die Namen
oder IP-Adressen der Server werden dabei durch Doppelpunkte getrennt (z. B. Server1:Server2:Server3).
Das Setup-Programm fügt dann dem Computer des Endbenutzers die erforderlichen Konfigurationsinfor-
mationen hinzu. Wenn das Produkt bereits auf den Computern installiert ist, können Sie die folgenden
Schritte ausführen, um die Konfigurationsinformationen hinzuzufügen. Sie können auch zunächst eine
Deinstallation und anschließend eine neue Installation übertragen, bei der alle Server festgelegt sind. In-
formationen zum automatischen Übertragen von Installationen finden Sie unter „Übertragen einer Instal-
lation an Windows-Computer” auf Seite 9. Wenn das Produkt bereits auf den Computern installiert ist,
können Sie die folgenden Schritte ausführen, um die Konfigurationsinformationen hinzuzufügen. Sie kön-
nen auch zunächst eine Deinstallation und anschließend eine neue Installation übertragen, bei der alle
Server festgelegt sind. Informationen zum automatischen Übertragen von Installationen finden Sie unter
„Übertragen einer Installation an Windows-Computer” auf Seite 9.
1. Öffnen Sie die Datei spssprod.inf in einem Texteditor. Unter Windows befindet diese Datei sich im Pro-

duktinstallationsverzeichnis auf dem Desktop-Computer.
2. Setzen Sie die Zeile für DAEMONHOST auf Kommentar. Beispiel:

#DAEMONHOST=server1

3. Fügen Sie eine neue Zeile für RedundantServers hinzu und setzen Sie den Wert auf die durch Doppel-
punkt getrennten Namen bzw. IP-Adressen der Server. Beispiel:
RedundantServers=server1:server2:server3

4. Speichern Sie spssprod.inf.

Konfigurieren von Pendlerlizenzen
Mit Pendlerlizenzen können Endbenutzer Lizenzen aus dem Lizenzmanager auschecken, sodass sie diese
Lizenzen verwenden können, auch wenn sie nicht mit dem Netz verbunden sind. Pendlerlizenzen sind
standardmäßig aktiviert. Anweisungen für das eigentliche Auschecken der Pendlerlizenz finden sich in
den Installationshinweisen für Endbenutzer.

Sie können den Prozentsatz der Lizenzen auf dem Lizenzmanagerserver beschränken, die für den mobi-
len Zugriff aktiviert werden. Es empfiehlt sich, die Anzahl der Pendlerlizenzen zu beschränken. Damit
wird verhindert, dass sich alle verfügbaren Lizenzen im mobilen Einsatz befinden. Wenn der angegebene
Prozentsatz an Lizenzen von mobilen Anwendern aufgebraucht wurde, stehen keine weiteren Lizenzen
zur Verfügung, bis die mobilen Lizenzen ablaufen oder wieder eingecheckt werden. Sie können außerdem
die Dauer festlegen, für die mobile Lizenzen ausgecheckt werden können. In der Standardeinstellung be-
trägt die maximale Dauer 3 Tage.

Wichtig: Wenn Sie redundante Lizenzserver mit Pendlerlizenzen verwenden, gestattet nur der primäre
Lizenzserver den Benutzern, Pendlerlizenzen aus- und einzuchecken. Bei einem Ausfall des primären Li-
zenzservers können die Benutzer keine Lizenzen ein- und auschecken.

Festlegen des Prozentsatzes der verfügbaren Pendlerlizenzen
1. Erstellen Sie auf dem Lizenzmanagerserver eine Umgebungsvariable mit dem Namen LSERVOPTS. Die-

se Variable wird unter Windows während der Lizenzmanagerinstallation erstellt, sodass Sie diesen
Schritt nur für die anderen Betriebssysteme durchführen müssen.
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2. Ändern Sie den Wert der Umgebungsvariablen LSERVOPTS, indem Sie -com <Prozentsatz> aufnehmen.
Hierbei stellt <Prozentsatz> einen numerischen Wert zwischen 0 und 100 dar, der den Prozentsatz an
Lizenzen angibt, die für den mobilen Zugriff verfügbar sind. Mit der Angabe 0 stehen keine Lizenzen
für den mobilen Zugriff zur Verfügung. Dieser Schalter ist unter Windows standardmäßig enthalten
und auf 0 festgelegt.

3. Starten Sie den Computer neu, auf dem der Lizenzmanager ausgeführt wird.

Festlegen der maximalen Zeitdauer für Pendlerlizenzen

Die maximale Zeitdauer, für die die Endbenutzer eine Pendlerlizenz auschecken können, wird durch die
Einstellung CommuterMaxLife in der Datei spssprod.inf auf dem Desktop-Computer angegeben. Unter Win-
dows befindet sich diese Datei auf dem Desktop-Computer im Installationsverzeichnis des Produkts. Öff-
nen Sie die Datei spssprod.inf und suchen Sie nach CommuterMaxLife . Legen Sie den Wert dieser Option
auf die maximale Anzahl von Tagen fest, für die die Endbenutzer eine Pendlerlizenz auschecken können.
Der Wert sollte eine Zahl zwischen 1 und 30 sein. Sie können diesen Wert auch festlegen, wenn Sie die
Installation automatisch übertragen. Weitere Informationen finden Sie im Thema „Übertragen einer Instal-
lation an Windows-Computer” auf Seite 9.

Hinweis: Diese Funktion arbeitet mit einer Datums-, nicht mit einer Zeitangabe. Wenn Sie zum Beispiel
die Option CommuterMaxLife auf einen Tag setzen und dann eine Lizenz um 9.00 Uhr auschecken, wird
diese Lizenz nicht vor Mitternacht des Folgetages wieder eingecheckt. Auch wenn also CommuterMaxLife
auf einen Tag eingestellt ist, behält der Benutzer die Lizenz tatsächlich 39 Stunden lang.

Abrufen einer Liste der ausgecheckten Lizenzen in der Befehlszeile

Sie können ermitteln, welche Benutzer Lizenzen ausgecheckt haben.
1. Wechseln Sie über eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-

nistrators.
2. Geben Sie Ismon<Server> (Windows) oder ./lsmon <Server> (andere Betriebssysteme) ein. Dabei stellt

<Server> den Namen oder die IP-Adresse des Servers dar, auf der Lizenzmanager ausgeführt wird.
Sie können den Namen des Lizenzservers auslassen, wenn Sie nur die ausgecheckten Lizenzen für
den Server "localhost" anzeigen möchten.

Abrufen einer Liste der ausgecheckten Lizenzen in der Anwendung WlmAdmin

Sie können ausgecheckte Lizenzen auch in der Anwendung WlmAdmin anzeigen:
1. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben dem Li-

zenzmanagerserver.
2. Klicken Sie auf das Zeichen + neben Clients. Die Clients, die die Lizenz für gleichzeitig angemeldete

Benutzer nutzen, werden aufgelistet. Wenn keine Clients aufgelistet werden, verwendet kein Benutzer
die Lizenz für gleichzeitig angemeldete Benutzer.

3. Wählen Sie einen bestimmten Client aus, um anzuzeigen, ob der Client eine Lizenz ausgecheckt hat.
Überprüfen Sie nach der Auswahl den Bereich "Detaillierte Informationen" im rechten Fensterbereich.

Konfigurieren von Lizenzreservierungen
Sie können eine Reservierungsdatei erstellen, in der angegeben wird, wie viele Lizenzen für bestimmte
Benutzer oder Benutzergruppen reserviert werden. Die Benutzer werden durch Netz-IDs oder Compu-
ternamen (nicht durch IP-Adressen) identifiziert. Sie können zum Beispiel eine Reservierungsdatei einrich-
ten, mit der die Lizenz für eine Gruppe von Hauptbenutzern reserviert wird. Für diese Benutzer werden
die Lizenzen immer verfügbar sein. Mithilfe der Reservierungen können Sie auch verhindern, dass be-
stimmte Benutzer einen Zugriff auf die Lizenz bekommen.
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Erstellen einer neuen Reservierungsdatei
1. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung WlmAdmin aus:

Edit > Reservation File

Dadurch wird die Anwendung Wlsgrmgr geöffnet.
2. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung Wlsgrmgr aus: File > New.

Hinzufügen von Lizenzen und Benutzer zur Reservierungsdatei
1. Wählen Sie die folgenden Befehle aus den Menüs der Anwendung Wlsgrmgr aus:

Feature > Add

2. Klicken Sie im ersten Bildschirm des Assistenten auf Weiter.
3. Geben Sie den Funktionscode für die entsprechende Lizenz an, die Sie reservieren möchten. Informati-

onen zum Abrufen der Funktionscodes für die entsprechenden Lizenzen finden Sie unter „Anzeigen
der Details zu einer Lizenz” auf Seite 12. Legen Sie außerdem eine bestimmte Version fest. Geben Sie
die Version hierbei so ein, wie sie in der Anwendung WlAdmin angezeigt wird (z. B. 160). Die Versi-
on ist nicht optional. Ignorieren Sie die Steuerelemente für "Capacity", weil Lizenzen dieses Typs nicht
unterstützt werden.

4. Klicken Sie auf Weiter.
5. Geben Sie für die Gruppe von Benutzern einen Namen an. Der Name ist willkürlich, er sollte jedoch

aussagekräftig sein (z. B. Vertrieb).
6. Geben Sie die Anzahl der Lizenzen an, die für diese Gruppe reserviert werden sollen. Die Gruppen-

mitglieder können auf alle Lizenzen zugreifen. Die Anzahl von Lizenzen, die Sie angeben, steht je-
doch nicht mehr für die Benutzer zur Verfügung, die nicht Mitglied dieser Gruppe sind. Dies bedeu-
tet: Wenn Sie von 10 Lizenzen 5 Lizenzen reservieren, können Mitglieder dieser Gruppe über 10
Lizenzen verfügen, während den anderen Benutzern nur 5 Lizenzen zur Verfügung stehen.

7. Klicken Sie im Fenster "Members" auf Add, um einen der Gruppe zugehörigen Benutzer oder Compu-
ternamen (keine IP-Adressen verwenden) anzugeben. Benutzer und Computer, die der Gruppe ange-
hören, können die reservierten Lizenzen verwenden. Benutzer und Computer, die der Gruppe nicht
angehören, können nicht auf die reservierten Lizenzen zugreifen. Geben Sie so viele Benutzer und
Systeme wie erforderlich an. Beachten Sie, dass sich die Gruppen gegenseitig ausschließen müssen.
Daher können verschiedenen Gruppen für dieselbe Lizenz nicht dieselben Benutzer oder Computer
enthalten.

8. Klicken Sie auf Fertigstellen, wenn Sie der Gruppe alle Benutzer hinzugefügt haben.
9. Fügen Sie nach Bedarf weitere Gruppen oder Lizenzen hinzu. Sie können Lizenzen und Gruppen

auch ändern oder löschen, indem Sie auf diese mit der rechten Maustaste klicken und die Option Pro-
perties auswählen.

Speichern der Reservierungsdatei
1. Wählen Sie folgenden Befehle aus den Menüs aus, wenn Sie die Reservierungsdatei fertiggestellt ha-

ben:
File > Save As

2. Speichern Sie die Datei an einem leicht zugänglichen Speicherort. Im nächsten Schritt müssen Sie die
Datei kopieren.

3. Um die Einstellung zu aktivieren, dass der Lizenzserver die Datei lsreserv beim Start automatisch fin-
det, kopieren Sie die Datei unter Windows in den Unterordner winnt im Lizenzmanagerinstallations-
verzeichnis. Wenn Sie den Standardspeicherort akzeptiert haben, wechseln Sie in den Ordner C:\
Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\License Manager. Auf anderen
Betriebssystemen kopieren Sie die Datei direkt in das Lizenzmanagerinstallationsverzeichnis.

4. Wenn Sie allen redundanten Servern dieselben Reservierungen zuweisen möchten, kopieren Sie die
Reservierungsdatei (lsreserv) auf jeden Server.

5. Starten Sie abschließend jeden Lizenzmanager neu.
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Starten und Stoppen des Lizenzmanagers
Die Methode zum Starten des Lizenzmanagers hängt von Ihrem Betriebssystem ab.

Windows

Auf Windows-Computern wird der Lizenzmanager als Systemdienst ausgeführt. Der Dienst wird stan-
dardmäßig automatisch gestartet. Falls Sie ihn dennoch einmal manuell starten müssen, gehen Sie wie
folgt vor:
1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.
2. Doppelklicken Sie auf Dienste.
3. Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.
4. Klicken Sie mit der rechten Maustaste auf den Dienst und wählen Sie die Option Starten oder Been-

den aus.

Andere Betriebssysteme

Auf anderen Betriebssystemen wird der Lizenzmanager als Dämonprozess ausgeführt. Führen Sie zum
manuellen Starten die folgenden Schritte aus. Sie können den Lizenzmanager auch zum automatischen
Starten konfigurieren (Anweisungen folgen).
1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
2. Starten. Geben Sie als Root an der Eingabeaufforderung ./lserv & ein und drücken Sie die Eingabe-

taste.
3. Beenden. Geben Sie als Root ./lsrvdown <Hostname> an der Eingabeaufforderung ein, wobei <Hostna-

me> der Netzname des Computers ist, auf dem der Lizenzmanager ausgeführt wird. Drücken Sie
dann die Eingabetaste.

Konfigurieren des Lizenzmanagers für den automatischen Start
Windows
1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.
2. Doppelklicken Sie auf Dienste.
3. Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.
4. Klicken Sie mit der rechten Maustaste auf den Dienst und wählen Sie die Option Eigenschaften aus.
5. Legen Sie als "Starttyp" Automatisch fest.
6. Klicken Sie auf OK.

Andere Betriebssysteme
1. Fügen Sie einer der Startdateien des Betriebssystems den Eintrag ./lserv & hinzu.

Deinstallieren des Lizenzmanagers
Windows
1. Wählen Sie im Windows-Startmenü Folgendes aus:

Einstellungen > Systemsteuerung

2. Doppelklicken Sie auf Programme hinzufügen/entfernen.
3. Wählen Sie den Eintrag IBM SPSS Concurrent Licensing Tools - License Manager aus und klicken

Sie dann auf Entfernen.
4. Klicken Sie auf Ja, wenn Sie gefragt werden, ob der Lizenzmanager entfernt werden soll.
5. Wählen Sie Sentinel RMS License Manager und klicken Sie anschließend auf Entfernen.
6. Klicken Sie auf Ja, wenn Sie aufgefordert werden, den Lizenzmanager zu entfernen.
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Andere Betriebssysteme
1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
2. Beenden Sie den Lizenzmanager, indem Sie als Root an der Eingabeaufforderung ./lsrvdown

<Hostname> eingeben, wobei <Hostname> der Netzname des Computers ist, auf dem der Lizenzmana-
ger ausgeführt wird. Drücken Sie anschließend die Eingabetaste.

3. Löschen Sie das Installationsverzeichnis des Lizenzmanagers.

Deinstallieren des Lizenzmanageradministrators
Windows
1. Wählen Sie folgende Befehle aus dem Menü "Start" von Windows aus:

Einstellungen > Systemsteuerung

2. Doppelklicken Sie auf Software.
3. Wählen Sie den Eintrag IBM SPSS Concurrent Licensing Tools - License Manager Administrator aus

und klicken Sie dann auf Entfernen.
4. Klicken Sie auf Ja, wenn Sie aufgefordert werden, die parallelen Lizenzierungstools zu entfernen.

Andere Betriebssysteme
1. Löschen Sie das Installationsverzeichnis des Lizenzmanageradministrators.

Fehlerbehebung bei Problemen mit den Desktop-Computern
Gehen Sie folgendermaßen vor, wenn die Desktop-Computer der Endbenutzer den Lizenzmanager nicht
finden können:
1. Führen Sie lswhere aus, um zu überprüfen, ob der Desktop-Computer den Netzcomputer finden

kann, auf dem der Lizenzmanager ausgeführt wird. Weitere Informationen finden Sie im Thema
„Ausführen von "Iswhere"”.

2. Vergewissern Sie sich, dass der Lizenzmanagerservice auf dem Netzcomputer ausgeführt wird.
3. Überprüfen Sie die entsprechende Datei spssprod.inf. Unter Windows befindet sich diese Datei auf dem

Desktop-Computer im Installationsverzeichnis des Produkts. Öffnen Sie die Datei spssprod.inf und ver-
gewissern Sie sich, dass für DAEMONHOST der richtige Name bzw. die richtige IP-Adresse des Computers
festgelegt ist, auf dem der Lizenzmanager ausgeführt wird. Wenn Sie redundante Server einsetzen,
darf kein Wert angegeben sein. RedundantServers sollte alle definieren. Die Namen müssen durch
Doppelpunkte (:) getrennt sein. Wenn es sich beispielsweise bei den Lizenzmanagercomputern um
SERVER1, SERVER2 und SERVER3 handelt, wird RedundantServers auf SERVER1:SERVER2:SERVER3 ge-
setzt.

Ausführen von "Iswhere"
lswhere kann über den Desktop-Computer eines Endbenutzers ausgeführt werden, um zu ermitteln, auf
welchem Computer der Concurrent License Manager ausgeführt wird.
1. Wechseln Sie per Eingabeaufforderung in das Installationsverzeichnis von IBM SPSS Modeler.
2. Geben Sie lswhere ein.
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